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1
Introduction to the Active System 800 Solution
Today, many IT organizations are missing deadlines or cannot respond fast enough to customer demands, have 
insufficient IT budgets, or have to manage trade-offs. In response, convergence in the data center has emerged as a 
trend in IT to address the growing needs for agility, efficiency, and quality. IT organizations are rapidly adopting 
converged infrastructure solutions to lower the cost of running critical workloads, enable faster infrastructure 
deployments, and drive simplicity and speed of management. Below are some high-level solutions for the Dell™ Active 
System (AS) 800:

• Rapid and Simple Scalability — The Dell Active System 800 is a part of the Active Infrastructure family, which 
includes fully pre-integrated converged infrastructure solutions. As one of the pre-integrated solutions offered, 
the Dell Active System 800 is a scalable blade server and storage infrastructure designed to support private 
cloud infrastructures. Able to add compute and storage capacity as needed in a non-disruptive manner, the 
Active System 800 offers many different configuration options for varying business conditions and sizes for a 
highly utilized IT infrastructure.

• Quick and Easy Provisioning — The Dell Active System 800 allows for more rapid application deployments 
through minimized design, test, procurement, integration, and configuration phases. One key feature of the 
Active System 800 is the Active System Manager, which offers streamlined, automated processes, as well as a 
quick response to dynamic business needs through template-based, modular infrastructure provisioning. This 
allows IT infrastructures to achieve higher efficiencies and more accurate delivery of IT services. A single IT 
generalist can manage most common tasks via the streamlined and automated processes delivered through the 
Active System Manager.

• Automated and Efficient — The Dell Active System 800 enables your data center to reach its maximum potential, 
and reduces the complexity and amount of time spent manually managing storage functions through automation 
for a more efficient and simplified management. This allows the Dell Active System 800 to support the efficient, 
agile delivery of applications and IT services made possible by a private cloud infrastructure, delivering true IT 
as a service through private cloud benefits such as self-service portals and chargebacks.

This document describes the deployment and management of Active System Manager 7.1 on Active System 800 
infrastructures.

Support
Contact Dell technical support by visiting the following web site:

www.dell.com/support/softwarecontacts

Technical Documentation
The Dell Active System Manager documentation enables you to better understand your current Active Infrastructure, its 
deployment, and management software.

For this release, we recommend that you familiarize yourself with the following documentation:

• Active System 800 Spec Sheet

• Active System 800 VMware ESX 5.x Reference Architecture

• Active System Manager 7.1 User Guide

• Active System Manager 7.1 Web Interface User Guide
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To access the latest Active System Manager documentation for Version 7.1:

1. Navigate to www.dell.com/support/manuals, click Choose from a list of all Dell products and click Continue. 

2. Click Software and Security → Enterprise System Management → Active System Manager → Dell Active System 
Manager Version 7.1.

Overview
This section provides a high-level product overview of the Active System supported components and configurations.

The following table lists the Active System Manager solution for the Active System 800-supported components.

Active System 800-Supported Components

Component Details

VMware vSphere 5.1 Hypervisor Up to 2x Dell PowerEdge M1000e chassis with up to 32x Dell 
PowerEdge M620 Blade Servers and embedded VMware 
vSphere 5.1

Converged Fabric Switch • 2x Dell Force10 S4810
• 2x Dell PowerEdge M I/O Aggregator in each Dell
• PowerEdge M1000e chassis

Storage Up to 8x Dell EqualLogic PS6110 series arrays

Management Infrastructure • 2x Dell PowerEdge R620 servers with embedded 
VMware vSphere 5.1 hosting management VMs

• 1x Dell Force10 S55 used as a 1GB out-of-band 
management switch

Management components hosted in the management 
infrastructure • Dell Active System Manager

• VMware vCenter Server
• Dell Management Plug-In for VMware vCenter
• Dell OpenManage Essentials
• Dell EqualLogic Virtual Storage Manager (VSM) for 

VMware
• Dell EqualLogic SAN Headquarters (HQ)
• VMware vCloud Connector
• Dell Repository Manager

The following table lists the Active System Manager solution for the Active System 800-supported configurations.

Active System 800-Supported Configurations

Configuration Support

M1000e chassis and supported blade types 
(M620)

Support firmware images as per the Active System Manager solution for 
Active System 800

Dell Force10 Top-of-Rack (ToR) S4810 
switches

Supported FTOS and base configuration will be packaged in the virtual 
appliance. The base configuration should be updated for management IP 
and virtual LAN (VLAN) per data center deployment need.

Dell EqualLogic PS6110 Storage Array Supported firmware versions will be packaged in the virtual appliance.
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Configuration Support

VMware vCenter 5.1 for virtual machine 
(VM) workloads
ESXi 5.1 installation support on blade 
servers

Supported ESXi 5.1 image will be bundled in the virtual appliance
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2
Active System Manager Deployment
This section describes the options, prerequisites, and methods to deploy Active System Manager.

Deployment Options
The Active System Manager solution for Active System 800 is packaged as a virtual appliance and is made available for 
VMware vCenter 5.1:

• Open Virtualization Format (OVF) for VMware — The disk format is VMware virtual machine disk (VMDK).

For details on deployment, see the following table.

Deployment Options

Virtual Appliance Filenames Platform

Dell-
ActiveSystemManager-7.1.0.xyztp_VM
ware.zip

VMware vCenter 5.1

Deployment Prerequisites
Before using the Active System Manager solution for end-to-end provisioning of Active System 800 components, make 
sure that the prerequisites listed in the following table are in place:

Deployment Prerequisites

Specification Prerequisite

Connection requirements Active System 800 units connected per the Active System 800 Reference 
Architecture and Design Guidelines.

Management server requirements Management server is configured per the Active System 800 Reference 
Architecture and Design Guidelines.

Firmware and BIOS requirements All equipment must be configured with firmware versions as listed in 
Appendix C — Firmware and Software Base Lineup section.

For the Active System 800 chassis, blade 
server, and IO Aggregators • CMC for M1000e chassis is configured and has the management 

IP address and login credentials assigned.
• Server iDRAC and IOA are configured and has the management IP 

address and login credentials assigned using CMC Management 
interface.

NOTE: The username (root) and password for CMC, IOA, and iDRAC 
must be identical.

Dell Force10 S4810 switches (Top-of-Rack 
[ToR]) • The management IP address is configured for the ToR switches.

• The A800 base configuration is applied on both switches.
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Specification Prerequisite

• VLANs are created on the switches per the Active System 800 
deployment specification.

• The Active System Manager dynamically creates the virtual 
machine (VM) traffic VLANs.

EqualLogic Storage Array • The management IP addresses are configured for Storage Array.
• All storage array members are added to the group.
• Storage is configured per the AS800 Deployment guide for DCB 

storage enablement.

VMware vCenter 5.1 • vCenter 5.1 is configured and accessible via the management and 
hypervisor management network.

• Appropriate licenses are deployed on the vCenter.

PXE Setup for server deployment • Details for deploying PXE Server are listed in Appendix G — PXE 
Setup Requirements section. This setup is needed for PXE boot of 
the servers only.

Deploying OVF
The Active System Manager Open Virtualization Format (OVF) can be imported on to an ESXi host using the VMware OVF 
import process. When booted, the Active System Manager VM gets its IP address from an existing DHCP server. If the 
DHCP server is not configured, assign the IP address manually to the appliance.

Importing OVF from the vSphere Client

1. On the vSphere Client menu bar, click File → Deploy OVF Template .
The Deploy OVF Template wizard is displayed.

2. Click Browse and select the OVF file (Active-System-Manager-7.x-Build-xxxxx_VMware.ovf), and click Next. 

3. Enter the VM name, and click Next. 

4. Select the appropriate datastore name to host the VM, and click Next.

5. Select the disk format. (Thin provisioning is supported and recommended.) and click Next.

6. Select the network name. The VM must be mapped to the Hypervisor Management Network. All networks (for 
example, OOB, Hypervisor Management, vMotion, iSCSI, and VM workloads) are expected to be accessible from 
the appliance. 

7. Use the following necessary key access credentials.

Key Access Credentials

VM Access Credentials Username/Password

Active System Manager server installation login delladmin/delladmin

Active System Manager server root root/Dell@123

Active System Manager application admin/admin

12



Changing Key Access Credentials
Passwords should be changed at the time of deployment. You should change the passwords before creating or 
changing any of the software repositories.

1. Stop Active System Manager services:
a) Log in as user delladmin.
b) Execute following commands:

cd $HOME/asm-galeforce/gf/sbin

./stopasm.sh

Make sure that all of the services are stopped before continuing.

2. Change the passwords using the standard Linux command passwd to change the passwords for any of the three 
stock accounts.

– root

– delladmin

– oracle

You will need root access to modify the passwords. Run the following commands:
   su
   <Enter root password>
   passwd delladmin
   <Enter new password>
   <Re-enter new password>

3. Repeat these steps until all three user accounts have been modified.

NOTE: Do not rename the user accounts, only change their passwords.

4. Reboot your Active System Manager VM.
After you have changed your passwords you must reboot your Active System Manager VM. Before you reboot, 
make any other changes such as IP address or time (NTP) configurations and then reboot once to encompass all of 
your changes.

5. Update any already existing software repositories that are running on the Active System Manager appliance.
Most of your software repositories depend on credentials to be able to access firmware, ISO files, PXE boot files, 
etc. If the passwords are changed as part of an initial deployment, there will be fewer repositories to update with 
the new credentials. If you change passwords on an Active System Manage server that has been in use for a while, 
you may have many more repositories to update.

Key Access Credentials

VM Access Credentials Username/Password

Active System Manager server installation login delladmin/delladmin

Active System Manager server root root/Dell@123

Active System Manager client applications admin/admin

Assigning IP Address to the Active System Manager Appliance
1. On the vSphere or Hyper-V Manager client, select the deployed Active System Manager appliance and open its 

console.

2. Log in as the root user. Root user credentials are given Key Access Credentials.
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3. Navigate to System → Preferences → Network Connections .
The Network Connections dialog box is displayed.

4. In the Wired tab, select the network interface card (NIC) appliance on which IP address should be configured 
manually and click Edit.

5. In the Editing dialog box, click the IPv4 Settings tab. Select Manual for the Method.

6. Click Add and enter the IP address and other networking information (for example, DNS). Click Apply.

7. Open the terminal console by clicking Applications → System Tools → Terminal. 

8. Execute the following command:
/etc/init.d/network restart 

9. Log in to the appliance with the newly configured IP address. This will ensure that the IP address is configured 
correctly on the appliance.

Accessing the Active System Manager Web Client for the First 
Time
To access the Active System Manager web client, perform the following steps:

NOTE: If you are trying to access the Active System Manager for the first time, you must have a valid license to log 
on to the Active System Manager web portal.

1. In your internet browser, enter the following URL:

http://<Active System Manager server name>:<Active System Manager port number>

The copyright information displays and after a few seconds, the Please Sign In page displays.

2. In the Please Sign In page, enter the default Username and Password, and click Sign In.

NOTE: The administrator can use the factory-supplied default credentials. Using these default credentials, the 
super administrator can create multiple administrators.

3. In the License Deployment page, copy and paste the content of the license file provided in the License File text box. 
Click Submit to log on to the Active System Manager.

Adding Additional Licenses
To add license:

1. Perform one of the following methods:

– To add license using the web client, click Settings → License on the menu bar.

– To add license using the thick client, click Tools → Settings on the menu bar, and click the License tab.

The License screen displays the current licensing information and associated live (current) counters.

2. Optional. In the License screen, click the Refresh icon to refresh the resource count and view the currently 
allocated resources.

3. Click Get New License. The next license screen allows you to request and deploy or install new product license.

4. In the Request Product License section, click NOW and enter the following contact details:

– First name

– Last name (optional)

– Email address

– Company name

– Group or organization name
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5. Click Send Email to send an email (support@dell.com) to the Dell Support team, requesting for a product license.
The Dell Support team responds to your software license request with a license file.

6. In the Deploy Product License section, copy and paste the content of the license file provided in the License File 
text box.

7. Click Submit.

Configuring Active System Manager Services

Starting Services Manually

The appliance is configured to start Active System Manager services during start-up.

1. Log in as delladmin user.

2. Execute the following command:
cd $HOME/asm-galeforce/gf/sbin
./startasm.sh

NOTE: The Active System Manager services must not be started by the root user.

Stopping Services Manually

1. Log in as delladmin user.

2. Execute the following command:
cd $HOME/asm-galeforce/gf/sbin
./stopasm.sh

Verifying Active System Manager Service Status

1. Log in as delladmin user.

2. Run the following script to display the current status of all services, including the Oracle database status:
cd asm-galeforce/gf/sbin
./asmstatus.sh
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Sample output
                    Active System Manager Services Status
Installation
----------------
Release Version: 7.1
Build Number: 471
Database
----------------
Vendor: Oracle (Ver: 11.2.0.1.0)
Host: asm-galeforce Port: 1521
Service name: DB11G
Status: Running
Active System Manager Service
----------------------------------
Host: asm-galeforce Port: 40500 Secure Port: 50500
Enterprise: Dell
Lab: DEMO
Status: Running
Domain Services
----------------
1. Domain     : System (Id: 1)
   Description:
   ------------------------------------------------------
   Session server
      Host: asm-galeforce  Port: 40500  Secure Port: 50500
      Status: Running  

Installing the Active System Manager Client
You can install the Active System Manager Client on the following platforms:

• Windows

• Linux

This section describes the following installation procedures:

• Installing Active System Manager Client Software on Windows

• Installing Active System Manager Client Software on Linux

• Accessing Active System Manager Using the Windows Client Software
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Installing Active System Manager Client Software on Windows 

1. Download the Active System Manager installer:

– The win64 installer version should be downloaded for 64-bit Windows operating system.

– The win32 installer version should be downloaded for 32-bit Windows operating system.

2. On your desktop, click Start → Run → Browse, navigate to the setup.exe file, and click OK. Alternatively, from your 
Windows Explorer window, navigate to the setup.exe file and double-click it.
A Security Warning window prompts you to run the file.

3. Click Run and complete the installation wizard.

NOTE: If an existing version of the client is on the client machine, invoking the installer prompts you to select 
to uninstall the existing version already on the system. Once selected, the installer uninstalls the existing 
version and then exits. To install the new version, restart the installer.

4. Click Finish to complete the installation.

Installing Active System Manager Client Software on Linux

Download the Active System Manager installer:

• The x86_64 installer version should be downloaded for x86_64 operating system.

• The x86 installer version should be downloaded for x86 operating system.

The following procedure describes the steps to install and start x86 version client:

1. Download the ActiveSystemManager-linux.gtk.x86_7.1.0_xyzt.zip file.

2. Unzip the file into a specific folder destination on your hard drive.

3. Create an Active System Manager folder and move the file contents to this location.

4. In the console, execute the Active System Manager file.

Accessing Active System Manager Using the Windows Client Software

To access the Active System Manager through Windows client software, perform the following steps:

1. Launch the client software application. 

2. On the Connect to Active System Manager Server dialog box, click Setup.

3. On the Setting Up Accounts dialog box, click Add. 

4. Enter a unique and descriptive Account name for the account and Server IP address of the appliance. 

5. Click OK.

6. Select the account created earlier.

7. Enter the default user name and the password for the appliance.

8. Click OK to launch the Active System Manager application.
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3
Active System Manager Setup
To manage and deploy the blade server in the Active System 800, perform the following operations in the Active System 
Manager, in sequence:

1. User and Group Management

2. Discovering Active System 800 Components

3. Software Repositories Available in the Active System Manager Virtual Appliance

4. Configuring Networks

User and Group Management
You can manage users and groups within the Active System Manager by either entering individual users and groups, or 
by importing users from an external repository, such as Lightweight Directory Access Protocol (LDAP), Active Directory 
(AD), or Network Information Service (NIS).

For user management, log in to the Windows client and navigate to Tools → User and Groups . The Security 
Management — Users and Groups dialog box displays.

NOTE: Set the time zone to match the time on the workstation that the Active System Manager client is installed.

Security Management — Users and Groups

For details on user and group administration, see the “User Profile Management” chapter in the Active System Manager 
User Guide, which is downloadable from the Active System Manager 7.1 web portal (Help menu) or from the Thick client 
(Eclipse-based).
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Discovering Active System 800 Components
Discovery of the Active System 800 components includes:

• Dell M1000e Chassis

• Dell M620 Blade servers

• Dell PowerEdge M I/O Aggregators

• Dell Force10 Top-Of-Rack (ToR) S4810 switches

• Dell EqualLogic Storage Array

• VMware vCenter Server

Initiating Discovery

To initiate the Discovery process, perform the tasks in the following sequence:

1. Opening the Discovery Settings

2. Adding Details for the Active System 800 Unit

3. Adding vCenter System Properties 

4. Starting the Discovery Process

Opening the Discovery Settings
You can configure the discovery settings in the Discovery Configuration Setup editor.

To open the Discovery Configuration Setup editor, perform the following steps:

1. Connect to the Active System Manager Client using user credentials with Administrator privileges.

2. Select Tools → Discovery → Setup.

Adding Details for the Active System 800 Unit

NOTE: In general for all the devices, when defining names and provisioning parameters, you should avoid using the 
following special characters: @ # $ % ^ () + = " | } { [ ] . , | : ; " ' ? / > <

NOTE: The volume names of the Dell EqualLogic Storage Array can contain only alphanumeric characters, and the 
following special characters: colon (:), period (.), and dash (-).

To add details for the Active System 800 unit, in the Discovery Configuration Setup editor, click Add System. This feature 
displays the names of the Active System 800 components that will be discovered, for example:

• Dell Chassis

• Dell EqualLogic Storage Array

• Dell Force10

1. For Dell M1000e Chassis, provide the following element properties:

– Assettag — Required. Unique key or name used to import or identify the Dell M1000e Chassis within Active 
System Manager. For example, Assettag Dell_Chassis_001 (a unique name) can be used to track the 
chassis in Active System Manager.

– Username — Username to access and manage the Dell M1000e Chassis.

– Password — Password to access and manage the Dell M1000e Chassis.

– IP Address— Required. IP address for the Dell M1000e Chassis CMC. The CMC should be IP reachable 
from the Active System Manager server.
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– Chassis Fabric Purpose — Required. Chassis Fabric purpose must be defined for at least one fabric.

– iDrac Root Password — Required. iDrac root password that will be set on the servers.

– IOA/IOM Root Password — Required. IOA/IOM root password that will be set on the IOAs/IOMs.

– IOA/IOM SNMPv2 Community — Required. The SNMPv2 Community string that will be set on the IOAs/
IOMs.

2. For the Dell EqualLogic StorageArray system, provide the following element properties:

– Assettag — Required. Unique key or name for the EqualLogic Storage Array, which is used to import or 
identify an EqualLogic Storage Array in the Active System Manager. For example, Assettag 
Dell_EqualLogic_PS6100_1 (a unique name) can be used to track the EqualLogic array in Active System 
Manager.

– Username — Required. User name to access and manage the EqualLogic Storage Array.

– Password — Required. Password to access and manage the EqualLogic Storage Array.

– IP Address — Required. Management IP address for the EqualLogic Storage Array. The management IP 
should be reachable (via ping to test) from the ASM server Group IP of the EqualLogic Array should be IP 
reachable from the Active System Manager server.

NOTE: If there are multiple storage groups, there should be an entry for each of the Storage Group in the 
Discovery Configuration Setup view. To add new element in an existing Active System 800 unit, click Add 
Element, select Dell EqualLogic StorageArray, and provide required details to initiate discovery.

3. For Dell Force10 Switch (ToR) discovery, provide the following element properties and discovery attributes:

– Assettag — Required. Unique key or name for Dell Force10 Switch which is used to import or identify the 
Dell Force10 Switch in Active System Manager. For example, Assettag Dell_Force10-S4810_1 (a unique 
name) can be used to track the Dell Force10 Switch in Active System Manager.

– Username — Required. Username to manage the Dell Force10 switch.

– Password — Required. Password to manage the Dell Force10 switch.

– IP Address — Required. Management IP address for the Dell Force10 switch. This should be IP reachable 
from the Active System Manager server.

– Role — (Optional) Top/Bottom.

– SupportedVLANIDs — Required. VLAN IDs that could be provisioned on the Top-Of-Rack (ToR) switch. 
Sample input format (2..1024); the switch supports a VLAN range from 2 to 1,024.

NOTE: The parameters related to Terminal Servers are not applicable for Dell Force10 Switch 
discovery.

NOTE: The discovery or any other operation for Dell Force10 switches using Terminal Server is not 
supported in ASM 7.1.

– Terminal Server IP Address — Optional. Required if switch to manage is using the Terminal Server port.

– Terminal Server Port — Optional. Required if switch to manage is using Terminal Server port.

– Terminal Server Username — Optional. Terminal Server username (if configured).

– Terminal Server Password — Optional. Terminal Server password (if configured).

Adding vCenter System Properties

1. On the Active System Manager → System → vCenter configuration , click Add vCenter 

2. For VMware vCenter discovery, provide the following system properties:

– Name — Required. Unique key or name for VMware vCenter which is used to import or identify vCenter in 
the Active System Manager.

21



– Username — Required. Username to access and manage the vCenter. This user must have full 
administrator rights to the vCenter. If the vCenter Server is part of a Windows Domain, then enter the 
username as username@domain.

– Password — Required. Password to access and manage the vCenter.

– IP Address — Required. IP address for the vCenter application. This must be IP reachable from the Active 
System Manager server.

Starting the Discovery Process

1. Connect to the Active System Manager Client using user credentials with Administrator privileges.

2. On the menu bar, click Tools → Discovery → Start , which initiates the discovery process for components that 
were set up during the discovery configuration setup.
You can view the discovery progress from the task bar shown at the bottom of the client. 

If the discovery progress is initiated when a discovery process is already in progress, the Active System Manager 
user is prompted with a message, indicating the same.

Updating the Server Resource Instances
After completing the Active System 800 components discovery, update the following information manually for all the 
blade servers. These parameters will be used for configuring the ESXi Server.

1. On the left navigation menu, click Inventory.
The Resource Instances view in the Inventory perspective displays the list of discovered server instances.

2. In the Resource Instances view, perform one of the following actions:

– To update the parameters for a single server instance, right-click a server instance, select Open. Update 
the parameters specified in the following table.

– To update the parameters for multiple server instances, select multiple server instances, right-click and 
select Open with Multi-Editor. Use the spreadsheet editor that displays to update the parameters specified 
in the following table.

The parameters listed in the following table should be updated for each host in the ASM inventory. These are required 
for end-to-end ESX host provisioning.

Parameter Description

ESXServerHostname Host name to be assigned to the ESXi server.

ESXServerPassword Server root password to be assigned during unattended 
installation.

ESXiSCSIChapUsername iSCSI CHAP user name used to access volume of EqualLogic 
Storage Array.

ESXiSCSIChapSecret iSCSI CHAP secret corresponding to iSCSI CHAP user name.

Software Repositories Available in the Active System Manager 
Virtual Appliance
Configuring the following repositories is described in the Active System Manager User‘s Guide, Chapter 6 – Firmware 
Management:

• Updating Repository Elements for Dell Servers

Configuring the following repositories is described in this document:
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• Updating Repository Elements on EqualLogic Firmware Repository

• Updating Repository Elements for EqualLogic Storage Resource Pools

• Updating Repository Elements for PXE Bootable Images

• Updating Repository Elements for ISO Bootable Images

• Updating Repository Elements for IOA Switch Configuration and Images

• Updating Repository Elements for ToR Switch Configurations and Images

• Updating Repository Elements for VMware Baseline Images

Updating Repository Elements on EqualLogic Firmware Repository

The EqualLogic Storage Array repository contains firmware images for updating the firmware on EqualLogic Storage 
Arrays.

1. Open the Software Repositories view in the setup perspective by clicking Setup → Software Repositories on the 
thick client.

2. In the Software Repositories view, right-click and select Repositories.

3. On the Software Repository — Select Repository Type dialog box, click Software Repository.

4. Click one of the following option, select Equallogic Firmware Repository from the list, and then click Next.

– New — To create a new repository.

– Existing — To update the existing repository.

5. Specify the Name of the repository, and update the host (IP address), user name, password, port and the base 
directory (location on the server where firmware images are present) and click Next. This access information is for 
Active System Manager Appliance as EqualLogic Firmware images are managed on the appliance.
Repository Properties:

– Host IP — Address, can be ASM server IPAddress.

– Port — Repository Server Port, by default its value is 22.

– Username — Repository server use name, can be ASM server user name.

– Password — Repository server password, can be ASM server password.

– Base Directory — Repository server base directory path where firmware image files are copied. For 
example, /home/delladmin/EqualLogicFirmwareImages.

6. In the Software Repository — Repository Elements Discovery and Association dialog box, click Discover to display 
all the firmware images available on the image server.

NOTE: Before initiating ‘Discover’, make sure firmware image files should be copied at required location: /
home/delladmin/EqualLogicFirmwareImages

7. Click Associate to associate the image file with the required Resource Types (Dell EqualLogic Storage Array and 
EqualLogic Storage Pool).

Updating Repository Elements for EqualLogic Resource Pools

The EqualLogic Storage Resource Pool repository contains the information of the Storage Pools available on EqualLogic 
Storage Arrays.

To update the repository elements:

1. Open the Software Repositories view in the setup perspective by clicking Setup → Software Repositories on the 
thick client.

2. In the Software Repositories view, right-click and select Repositories.

3. On the Software Repository — Select Repository Type dialog box, click Software Repository.
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4. Click one of the following options, select EqualLogic Storage Resource Pool Repository from the list, and then click 
Next.

– New — To create a new repository.

– Existing — To update the existing repository.

5. Specify the Name, Host, Username, and Password, and then click Next.
These parameters correspond to storage Management IP address, username, password respectively.

6. On the Software Repository — Repository Elements Discovery and Association dialog box, click Discover to 
display all the storage pools available on the Storage Array.

7. Right-click the selected Resource Pool and set the Type to Image File, and click Finish.

8. Click Associate to associate the storage pools with the required Resource Types (Dell EqualLogicStorageArray and 
EqualLogic Storage Pool), and click Finish.

Updating Repository Elements for PXE Bootable Images 

To update the repository elements, perform the following steps:

1. Open the Software Repositories view in the setup perspective by clicking Setup → Software Repositories on the 
client.

2. In the Software Repositories view, right-click and select Repositories.

3. On the Software Repository — Select Repository Type dialog box, click Software Repository.

4. Click one of the following options, select PXE Bootable Images from the list, and then click Next.

– New — To create a new repository.

– Existing — To update the existing repository.

5. Update the Host attribute value with the IP address of the Active System Manager appliance. Click Next.

NOTE: 
The Username and Password are configured with default appliance user name and password. These needs 
to be updated in case the default username or password was changed.

6. In the Software Repository — Repository Elements Discovery and Association dialog box, click Discover to initiate 
the discovery of the repository files. A list of discovered elements are displayed.
This step is required only if a new image is added to the repository. 

NOTE: Before initiating ‘Discover’, make sure PXE image files should be copied at required location: /var/lib/
tftpboot

7. Right-click the discovered elements and set the Type to Image File, and click Finish.

8. Click Associate to associate the discovered elements with the required Resource Types Dell Servers, and click 
Finish.

Updating Repository Elements for ISO Bootable Images 

1. Open the Software Repositories view in the setup perspective by clicking Setup → Software Repositories on the 
client.

2. In the Software Repositories view, right-click and select Repositories.

3. On the Software Repository — Select Repository Type dialog box, click Software Repository.

4. Click one of the following options, select ISO Bootable Images from the list, and then click Next.

– New — To create a new repository.

– Existing — To update the existing repository.

5. Specify the repository name, and update the Host attribute value with the IP address of the Active System 
Manager appliance.
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The Username and Password are configured with default appliance user name and password. These need to be 
updated if the default user name/password is updated. The BaseDirPath value contains base directory path where 
ISO image image files are copied, by default its value /home/delladmin/ISOBootImages. 

Click Next.

6. Click Discover to initiate the discovery of the repository files. A list of discovered elements appears.
This step is required only if a new ISO image is added to the appliance.

NOTE: Before initiating ‘Discover’, make sure ISO image files should be copied at required location: /home/
delladmin/ISOBootImages

7. Right-click the discovered elements and set the Type to Image File, and click Finish.

Updating Repository Elements for IOA Switch Configuration and Images 

To update the repository elements, perform the following steps:

1. Open the Software Repositories view in the setup perspective by clicking Setup → Software Repositories on the 
thick client.

2. In the Software Repositories view, right-click and select Repositories.

3. In the Custom Repository — Select Repository Type dialog box, select Software Repository.

4. Click one of the following options, select Dell IO Module Firmware Repository from the list, and then click Next.

– New — To create a new repository.

– Existing — To update the existing repository.

5. Specify the Name, Description, and update the following Repositories Properties, and then click Next.

– Host — Repository Server IP Address, can be ASM server IPAddress.

– SSH Username — Repository server username.

– SSH Password — Repository server password.

– BaseDirPath — Image nad configuration file path after <TFTPRootPath>, >, by default its value is ‘Dell/
IOA’.

– TFTPRootPath — Repository server base directory path where Dell Force10 switch image files are copied. 
For example, if image files are located at /var/lib/tftpboot/images then base directory path value would 
be /var/lib/tftpboot

6. Click Discover to initiate the discovery of the repository files. The list of discovered elements in the repository 
displays.

NOTE: Before initiating ‘Discover’, please make sure IOA switch image and configuration files should be 
copied at required location. For example, if base directory path is /var/lib/tftpboot and BaseDirPath is/
Dell/IOA then image files should be copied at following location: /var/lib/tftpboot/Dell/IOA/images

7. Click Associate to associate the selected element with the Dell IOA resource type, and click Finish.

Updating Repository Elements for ToR Switch Configurations and Images 

To update the repository elements, perform the following steps:

1. Open the Software Repositories view in the setup perspective by clicking Setup → Software Repositories on the 
thick client.

2. In the Software Repositories view, right-click and select Repositories.

3. On the Custom Repository — Select Repository Type dialog box, click Software Repository.

4. Click one of the following options, select Force10 ToR Switch Configurations and Images from the list,and then 
click Next.

– New — To create a new repository.
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– Existing — To update the existing repository.

5. Update the Name, Description, and update the following Repositories Properties and click Next.

– Host — Repository Server IP Address, can be ASM server IPAddress.

– Port — Repository Server Port, by default its value is 69.

– Username — Repository server user name.

– Password — Repository server password.

– Communication Protocol — Protocol used to communicate (ssh/telnet).

– Base Directory — Repository server base directory path where Force10 switch image files are copied. For 
example, if image files are located at /var/lib/tftpboot/images then base directory path value would 
be /var/lib/tftpboot

6. Click Discover to initiate the discovery of the repository files. The list of discovered elements in the repository 
displays.

NOTE: Before initiating ‘Discover’, make sure Dell Force10 switch image and configuration files should be 
copied at required location. For example if base directory path is /var/lib/tftpboot then image files should be 
copied at following location /var/lib/tftpboot/images.

7. Right-click the discovered element, set the Type to Configuration File or Image File, and click Finish.

8. Click Associate to associate the selected element with the Dell Force10Switch resource type, and click Finish.

Updating Repository Elements for VMware Baseline Images

This repository contains VMware baseline images for creating VM clones.

1. Open the Software Repositories view in the setup perspective by clicking Setup → Software Repositories on the 
thick client.

2. In the Software Repositories view, right-click and select Repositories.

3. On the Software Repository — Select Repository Type dialog box, click Software Repository.

4. Click one of the following options, select VMware Baseline Images repository from the list, and then click Next.

– New — To create a new repository.

– Existing — To update the new repository.

5. Specify the repository name and update the VMware vCenter host (IP address), username, and password.

6. Click Next to display the list of repository files. 

7. Click Discover to initiate the discovery of the repository files. The list of VMs managed by the vCenter displays.

8. Right-click the discovered element, set the Type to Image File, and click Finish.

9. Click Associate to associate the selected element with the VMware VM resource type, and click Finish.

Configuring Networks
This section describes the network configuration required for orchestration and end-to-end configuration. For more 
information about networks, see the Active System Manager 7.1 User Guide Chapter 10, "Network Management". The 
various networks have to be configured prior to executing an orchestration:

Accessing the Network Configuration Setup

You can configure new networks and modify default networks in the Networking Configuration – Networking Setup 
view. To open this view, on the menu bar, click Tools → Discovery → Networking .
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Configuring the Networks

Active System 800 comes with five preconfigured networks. You should modify the networks based on the environment 
in which the AS 800 being used.

Configuring an Existing Network

To configure an existing network:

1. On the menu bar, click Tools → Discovery → Networking .

2. On the Networking Configuration – Networking Setup view, select a network type in the Networking Configuration 
section.
The list of existing networks that are part of the selected network type will be listed in the Active System Manager 
section.

3. In the Active System Manager section, select the network, and click Edit.

4. On the Edit Default dialog box, add or modify the networking parameters (for example VLAN ID, DHCP \ static) as 
specified in the following table. Click OK.
The follow table summarizes the list of values that needs to be configured for an existing network.

Network Configuration Details

Entry Details

Name Specifies the name of the Network.

NOTE: For every Network created, the name of the 
network should contain one of the below strings:

– HypervisorManagement
– SANiSCSI
– Workload
– HyperVClusterPrivate
– vMotionLiveMigration

Description Describes the network configuration.

VLAN ID Specifies the VLAN ID configured on the switch for the 
network type.

Configure Static IP address ranges Enables you to configure static IP addresses. Select 
this check box to configure static IP addresses.

Configuring a Static Network

To configure a static network:

1. On the menu bar, click Tools → Discovery → Networking .

2. In the Networking Configuration – Networking Setup dialog box, select a network type in the Networking 
Configuration section.
The list of existing networks that are part of the network type will be listed in the Active System Manager section.

3. In the Active System Manager section, select the network, and click Edit.

4. On the Edit Default dialog box, select the Configure static IP address ranges check box.
The options to configure the static IP Address range are displayed.

5. Perform one of the following actions and click OK.
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– To add new IP address range, click Add IP Range , specify the Starting IP Address and Ending IP Address. 
Click Save IP Range

– To modify or configure the existing IP range, select an IP address range, click Edit IP Range and specify the 
Starting IP Address and Ending IP Address. Click Save IP Range

For details on configuring existing network parameters, see Configuring an Existing Network section.

The following table summarizes the list of values that needs to be configured for a network.

Network Configuration Details

Entry Details

Name Specifies the name of the Network.

NOTE: For every Network created, the name of the 
network should contain one of the below strings:

– HypervisorManagement
– SANiSCSI
– Workload
– HyperVClusterPrivate
– vMotionLiveMigration

Description Describes the network configuration.

VLAN ID Specifies the VLAN ID configured on the switch for the 
network type.

Configure Static IP address ranges Enables you to configure static IP addresses. Select 
this check box to configure static IP addresses.

Gateway Specifies the gateway of the network.

Subnet Mask Specifies the subnet mask of the network.

Primary DNS Specifies the Primary DNS.

Secondary DNS Optional. Specifies the Secondary DNS .

DNS Suffix Specifies the domain name.

Starting IP Address Specifies the starting IP address.

Ending IP Address Specifies the ending IP address.

Configuring Default Server Templates

The Active System 800 orchestration applies the server templates to the server at the time of setup. For more information 
about server templates and profiles, see the Active System Manager 7.1 User Guide Chapter 7, "Server Templates and 
Profiles" and for more information on configuring the default templates, refer to the Server Profile Templates document.

NOTE: 
Perform the following steps if multiple VM Workload VLANs are required:

1. On the Active System Manager Operation Center view, right-click a server template in the Server Templates 
And Profiles tab, and click Edit.

2. In the Edit Server Profile Template wizard, navigate to the Network Settings window by clicking Next. 

3. Click Add and specify the required parameters in the Add vNIC Configuration to add multiple VM Workload 
VLANs.

NOTE: For every Server Template created, the name of the server template should not contain spaces.
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NOTE: Server Template for Active System 800 VMware should have following names of VM NICs.

• HypervisorManagement

• vMotion

• Workload

• iSCSI

Map the Default Server Template networks with the networks configured on the ESXi server as specified in the following 
table.

Default ESXi Network Mapping

Network Type Server Template Network Name VMware ESXi Network Mapping

Hypervisor Management DefaultHypervisorManagement ESXi Management Network

Public LAN DefaultWorkload Virtual Machine Network

Private LAN DefaultvMotionLiveMigration ESXi VMotion Network

SAN iSCSI DefaultSANiSCSI ESXI iSCSI Network to access 
EqualLogic Storage Array.

NOTE: The following networks should have unique VLAN ID:

• Hypervisor Management

• Public LAN

• Private LAN

• SAN iSCSI

NOTE: Active System Manager does not pick up the workload VLAN based on the VLAN ID defined in the Network 
setting. The workload VLANs are randomly picked up based on the VLAN range defined for the layer 2 switch in the 
Active System Manager Inventory System. If a specific workload VLAN ID is needed, it should be specified in the 
VLAN Resource Type → Provisioning settings in the physical template.

NOTE: Attaching more than one Server Profile Template to a physical orchestration template will cause the 
physical orchestration to fail.

NOTE: DHCP is supported for Hypervisor Management, vMotion, and WorkLoad networks.

NOTE: SAN iSCSI networks must be configured with static IP Address configuration.

Creating Server Templates for PXE Boot Orchestration 

The server template for PXE boot orchestration can be created using an existing default VMware ISO Boot template. 
User is required to add the details of the Native VLAN in the HypervisorManagement network.

To create Server template for PXE boot orchestration::

1. On the Active System Manager Operation Center view, right-click a VMware server template to clone in the Server 
Templates And Profiles tab, and click Clone Template.

2. In the Edit Server Profile Template wizard, modify the cloned template, and navigate to the Network Settings 
screen by clicking Next. 

3. In the Network Settings screen, select the HypervisorManagement network type, and click Edit and modify the 
required parameters in the Edit vNIC Configuration dialog.

29



30



4
Physical Templates and Orchestration

Multiple Blade Server for Cluster Provisioning
Use the AS800 - Hypervisor Deployment ESXi - ISO - Cluster template to install ESXi 5.1 on an SD card using PXE or ISO 
boot.

You can specify one or more blade servers using these templates for creating a cluster.

Multiple Blade Server for Cluster Provisioning

While scheduling the template, user would be prompted to provide values for the orchestration parameters specified in 
the following table:

NOTE: 
The parameters such as ServerProfileTemplate with an icon associated with it are mandatory, while other 
parameters such as ESXServerLicenseKey are optional.

NOTE: Traffic shaping can limit the bandwidth usage of your VMs. To make sure that VMware Traffic Shaping is 
disabled for Workload before scheduling the Physical Orchestration for ESXi provisioning, complete the following 
procedure:

1. From vCenter, click on the ESXi host.

2. Click the Configuration tab.

3. Click on the Networking link.

4. Click on Properties of the vSwitch which contains the VM-Workgroup port group.

5. Click on the VM-Workgroup port group and click Edit.

6. Click the Traffic Shaping tab.

7. Select Disable in the drop-down menu.

8. Deselect Status.

9. Click OK.

10. Click Close 

Orchestration Input Parameters
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Category Parameter Input Type Description

Compute ServerProfileTemplate Mandatory Server Profile template which should be 
used for hardware configuration for blade 
servers.

ASMServerIPAddress Mandatory ASM appliance IP address.

ImageName Mandatory Selects the ESXi image from the repository. 
The orchestration is already mapped with 
an existing ESXi image available on the 
appliance.

ESXServerLicenseKey Optional License key for the VMware ESXi hosts that 
will be provisioned by the orchestration.

WorkloadBurstSize Mandatory Burst size for workload network.

WorkloadAverageBandwidth Mandatory Average bandwidth for workload network .

WorkloadPeakBandwidth Mandatory Peak bandwidth for workload network.

BootType Mandatory Boot media, ISO or PXE

Storage StoragePoolName Mandatory Name of the pool on which the volume 
should be created for provisioning the 
datastore. This input should be provided 
from the EqualLogic Resource Pool 
repository.

DatastoreVolumeSize Mandatory Size in GB of the datastore to be 
provisioned on servers or a cluster.

GoldDatastoreVolumeName Optional Volume name consisting of baseline VM 
images that will be used for cloning new 
VMs.

VCenter vCenterIPAddress Mandatory vCenter IP Address as provided in the 
Discovery Setup configuration.

vCenterDatacenter Mandatory vCenter data center to be used for 
provisioning.

vCenterFolderName Optional Folder name in a data center in vCenter to 
be used for provisioning.

vCenterClusterName Mandatory vCenter cluster name that will be 
provisioned by the orchestration.

NOTE: The cluster name passed as an 
argument must not be the 
Management cluster.

When this template is scheduled, it performs the following sequence of operations:

1. Reserves single or multiple VLANs for VM traffic using a VLAN component. If the VLANs reserved in the session 
are not already configured on the ToR switches, then the VLANs are created and tagged to appropriate port-
channels. 

2. IOA Configuration based on Networks defined in Server Profile template and VLAN defined in VLAN component:

a. VLAN’s associated with networks in the Server Profile template and VLAN defined in the VLAN component in 
the physical template are created on the IOA server facing interfaces as tagged VLANs.

b. The Native VLAN ID is added as untagged VLAN on the server facing interface.

c. The Native VLAN ID is mandatory for PXE boot scenario.
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3. NIC Partitioning as defined in Server Profile template.

4. Sets NIC Attributes as defined in Server Profile template.

5. Creates the ISO files for each server dynamically based on the Server IP Address, Hostname, Name server values 
provided in the database.

6. Mounts the ISO using iDRAC Virtual Media on all the servers and initiates the installation process. 

7. Configures the vSwitch configuration:

a. Creates the vSwitch and port-groups based on Active System 800 deployment specification.

b. Tags the port-groups with appropriate VLANs as specified in the template.

c. Creates iSCSI Port-groups and installs and or configures the MEM VIBs

8. Creates a volume of the EqualLogic Storage Array:

a. The new volume is created per physical session based on the size specified in the orchestration input.

b. The authentication of the new volume is configured based on the Chap username and secret key specified in 
the inventory database of the servers.

9. Creates a vCenter Cluster/Datacenter (if not already existing) on the specified vCenter. The cluster is created with 
default settings (DRS - On, HA - On, EVC - Disabled).
The cluster name passed as an argument must not be the Management cluster.

10. Adds hosts to the vCenter cluster.

11. The datastore created in the orchestration is used for provisioning the VM in the logical workload templates. 
Provides access to Gold volume and using Gold volume, creates base VMs.

12. Installs EqualLogic MEM modules. The MEM package is transferred to the volume created in the above step to 
enable the installation.

13. Registers base VMs to the vCenter for logical template provisioning.

NOTE: After the physical orchestration for AS800 VMware is complete, in the VMware vSphere client, update the 
following settings for the newly created Cluster:

• Navigate to Cluster → Edit Settings → vSphere HA dialog box and select the Enable: Disallow VM power 
on operations that violate availability constraints check box under Admission Control section.

• Navigate to Cluster → Edit Settings → VM Monitoring dialog box and select the Custom check box under 
Default Cluster Settings section.

Working with Clusters

Removing power from an ESXi cluster node deployed by Active System Manager (either by removing a server for service 
or from a power outage) causes storage connectivity to be lost upon reboot.

Active System Manager uses virtual MAC addresses as part of its ESXi provisioning strategy. When a server loses 
power these virtual mac addresses are not retained. Upon reboot the Broadcom iSCSI Adapters lose their configuration 
and subsequently lose their connectivity to the iSCSI storage volumes. The ability to retain the virtual MAC addresses 
after power is lost is a limitation of Dell server technology.

NOTE: There is no data loss in this situation.

The virtual MAC addresses are assigned to the server during the Attach Server Profile step during physical 
orchestration. In order to resolve the storage connectivity issue, run the Attach Server Profile step as a custom 
operation. To reassign the virtual MAC addresses to the each node in the cluster:

1. In Active System Manager, click Sessions.

2. Double-click the Session associated with the ESXi Cluster.

3. Right-click in the open area of existing Permanent Session and select Execute Orchestration.
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4. Select Configure ESXi Server using ISO Boot.

5. Deselect all the check boxes from all the steps in the Execute column with the exception of Attach Server Profile.

6. Click OK.

During the Attach Server Profile operation ALL ESXi node(s) that are associated with the session are rebooted. Down 
time will need to be scheduled in the scenario where a single node was serviced and the remaining cluster nodes are 
fine.

Single Blade Server for Standalone ESX Host Provisioning
Use the AS800 - Hypervisor Deployment ESXi - PXE - Standalone to install ESXi 5.1 on an SD card, using PXE Boot.

You can specify one or more blade servers for standalone ESXi host provisioning.

Single Blade Server for Standalone ESX Host Provisioning

While scheduling the template, user would be prompted to provide values for orchestration parameters which are same 
as defined in the Multiple Blade Server for Cluster Provisioning section.

NOTE: 
The parameters such as ServerProfileTemplate with an icon associated with it are mandatory, while other 
parameters such as ESXServerLicenseKey are optional.

1. From vCenter, click on the ESXi host.

2. Click the Configuration tab.

3. Click on the Networking link.

4. Click on Properties of the vSwitch which contains the VM-Workgroup port group.

5. Click on the VM-Workgroup port group and click Edit.

6. Click the Traffic Shaping tab.

7. Select Disable in the drop-down menu.

8. Deselect Status.

9. Click OK.

10. Click Close 

When this template is scheduled, the template performs the following sequence of operations:

1. Reserves single or multiple VLANs for VM traffic using a VLAN component. If the VLANs reserved in the session 
are not already configured on the ToR switches, then the VLAN is created and tagged to appropriate port-
channels. 
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2. IOA Configuration based on Networks defined in Server Profile template and VLAN defined in VLAN component:

a. VLAN’s associated with networks in the Server Profile template and VLAN defined in the VLAN component in 
the physical template are created on the IOA server facing interfaces as Tagged VLANs.

b. The Native VLAN ID provided for Network1 is added as untagged VLAN on the server facing interface.

c. The Native VLAN ID is mandatory for PXE boot scenario.

3. NIC Partitioning as defined in Server Profile template.

4. Set NIC Attributes as defined in Server Profile template. 

5. Create the ISO files for each server dynamically based on the Server IP Address, Hostname, Name server values 
provided in the database.

6. Mount the ISO using iDRAC Virtual Media on all the Servers and initiate the installation process. 

7. Configure the vSwitch configuration

a. Create the vSwitch and port-groups based on Active System 800deployment specification

b. Tag the port-groups with appropriate VLANs as specified in the template

c. Create iSCSI Port-groups and install / configure the MEM VIBs

8. Create a volume of the EqualLogic Storage Array

a. The new volume is created per physical session based on the size specified in the Orchestration input.

b. The authentication of the new volume is configured based on the CHAP username and secret key specified in 
the inventory database of the servers.

9. Add hosts to the vCenter at data center level.

10. The datastore created in the orchestration is used for provisioning the VM in the logical workload templates. 
Provides access to Gold volume and using Gold volume, creates base VMs.

11. Installs EqualLogic MEM modules. The MEM package is transferred to the volume created in the above step to 
enable the installation.

12. Registers base VMs to the vCenter for logical template provisioning.

NOTE: After the physical orchestration for AS800 VMware is complete, in the VMware vSphere client, update the 
following settings for the newly created Cluster:

• Navigate to Cluster → Edit Settings → vSphere HA dialog box and select the Enable: Disallow VM power 
on operations that violate availability constraints check box under Admission Control section.

• Navigate to Cluster → Edit Settings → VM Monitoring dialog box and select the Custom check box under 
Default Cluster Settings section.

Associated Orchestrations with Cluster and Standalone Host 
Templates
Each physical template has three orchestrations associated with it:

On-demand Orchestrations
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• Ondemand — VMFS Datastore Provision TBD Per Jerry Ness, need more detail around the missing task that a 
VMFS datastore LUN for the GOLD images must be initially created on the storage before the logical templates 
can be run. This orchestration can be executed on-demand when the session is in a Running state.

• Setup — Configures the ESXi Servers using PXE Boot. This orchestration executes when template provisioning 
starts and the session is in the Setting-Up state.

• Teardown — Cleanup-Orchestration. This orchestration executes when the template provisioning starts and the 
session is in Cleaning–UP state.

Additional Storage for Cluster or Host
For additional storage or datastore needed on a cluster host reserved through the Active System Manager, you can 
execute on-demand orchestration from a running session

For executing on-demand orchestration, open the session by double-clicking it. On the session, right-click on the 
session and select Execute Orchestration → VMFS Datastore Provision.

Orchestration performs the following sequence of operations:

• Creates new volume on EqualLogic storage.

• Allows access to specific cluster or standalone ESXi hosts, as applicable.

• Creates a VMFS datastore on a cluster or standalone ESXI hosts, as applicable.

Updating Physical Templates
To update the cluster and standalone templates that require specific data before scheduling a template for cluster 
provisioning (for example, to increase the blade server count for cluster and update the VLAN for template), perform the 
following steps:

To update the blade server count for the cluster:

1. In the Template editor, select the blade server.

2. In the Properties section, click the Resource tab.
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3. Click the Object Count field and specify the number of blade servers.

To update the VLAN Parameters:

1. In the Template editor, select the VLAN component.

NOTE: The VLAN defined in the VLAN component are the Workload VLAN’s, other VLAN’s should be statically 
configured on the ToR switches.

2. In the Properties section, click the Provisioning tab.

3. Update the VLAN parameters in the following fields:

– VLANCount — Specify the number of VLANs to be provisioned.

– VLAN Id — Specify the VLAN ID range. For example, (100..104),106

4. Press Ctrl + S or click Save on the thick client to save the template.

Providing Values to the Orchestration Operation Parameters
You can specify the parameter values for an orchestration operation using the Specify Input Values dialog box.

To access the Specify Input Values dialog box and add values to the orchestration parameters, perform the following 
steps:

1. In the Orchestration editor, drag an operation from the Available Operations view pane to the Orchestration View 
pane.

2. In the Specify Input Values dialog box, you can specify the parameter values for an operation using the following 
methods:
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– Pass by value — In the Parameter section, you can type the values directly. The specified value is added to 
the parameter.

– Pass by reference – Under Possible Values section, select the Primary Source and Secondary Source from 
the drop-down list. Expand the source and then click the check box next to value. You can select multiple 
values. The selected values are added to the parameter. The system will resolve the actual value of these 
parameters at runtime.

NOTE: These methods can be used interchangeably as required. However, if you have already selected a value for 
a parameter from the Possible Values section, and now you want to modify by typing in the value, then make sure 
that you clear the check box next to the selected value in the Possible Values section. Therefore, the system can 
understand that this is “Pass by value” method.
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5
Workload Provisioning Using Logical Templates
This section describes the following workload provisioning options using the Logical templates. Refer to the VMware RA 
readme.txt file for customizing the Virtual Machines authored in the templates.

NOTE: The default value for the InstallVirtualizationGuestServices parameter is True. Changing this parameter to 
False can cause your orchestration to fail.

• Two VMs with a VLAN
• Single Virtual Machine with VLAN
• Updating a Baseline VM Image on Logical Templates
• Pre-requisite to Provision a Virtual Machine

Two VMs with a VLAN
The Dual VM Sample template can be used to create VM workloads by scheduling a logical template over existing 
physical resources sessions, to consume the compute and storage resources of specific physical components.

Two VMs Connected to a VLAN

When scheduled, the template performs the following sequence of operations:

• Clones and powers on two VMware VMs based on the Gold VM Image associated with the template.
• Creates port-groups corresponding to VLAN component on vSwitch.

NOTE: While scheduling a template with VM having multiple interfaces, even if VM is mapped to a Host having 
muliple interfaces, all the interfaces of VM are mapped to the same interface of the Host.

After the VMs are provisioned, the user can also launch custom applications using custom methods.

To launch an application:

1. Right-click a VM in a session.

2. Select Applications.

3. Select the application to be launched.

Single Virtual Machine with a VLAN
The Single VM Sample template can be used to create VM workloads by scheduling logical template over existing 
physical resources session, to consume the compute and storage resources of specific physical components.
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Single VM Connected to a VLAN

When scheduled, the template performs the following sequence of operations:

• Clones and powers on a single VMware VM based on the Gold VM image associated with the template.

• Creates port-groups corresponding to a VLAN component on the vSwitch.

• Once the VMs are provisioned, you can also launch custom applications using custom methods from the Active 
System Manager Windows client.

NOTE: While scheduling a template with VM having multiple interfaces, even if VM is mapped to a Host having 
muliple interfaces, all the interfaces of VM are mapped to the same interface of the Host.

Updating a Baseline VM Image on Logical Templates
To update the baseline virtual machine (VM) image associated with the VM object in the template, perform the following 
steps:

1. Select the VM object in the template and click the Image Files tab.

Image Files Properties

2. Select the already associated image file and click Remove to remove the existing association.

3. Click Add and select the gold VM image to be associated with the VM object.
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Prerequisite to provision a Virtual Machine
There must be Golde VM exists in data center. This Gold VM will be associated as image file in the ASM template to 
clone VM. This is required because after the guest customization, the VM receives a proper IP address, which is 
reachable from domain.
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6
Operation Center View — Administrative 
Operations
This section describes the administrative operations available in the Operation Center view:

• Managing Dell Blade Servers
• Managing Dell Force10 IOA Switch
• Managing Dell Force10 ToR Switch
• Managing Dell EqualLogic Storage
• Managing VMware vCenter Objects

Managing Dell Blade Servers
Blade servers along with their attributes are discovered and populated in the Active System Manager Operation Center 
view. This view enables methods to be executed on the blade servers for on-demand provisioning, as required.

Blade Server Operations

Operation Description

Attach Server Profile This method attaches a server profile to a server.

Detach Server Profile This method detaches a server profile from a server.

Power Off Server This method is used to power off the blade servers using 
server iDRAC.

Power On Server This method is used to power on the blade servers using 
server iDRAC.

Update firmware on server This method applies firmware DUPs components (LC, 
iDRAC, BIOS) on a server.

Managing Dell Force10 IOA Switch
Dell Force10 IOA along with their attributes are discovered and populated in the Active System Manager Operation 
Center view. This view enables methods to be executed on Dell IOA for on-demand provisioning, as required.

Dell IOA Switch Operations

Operation Description

Configure IOA Switch This method is used to upgrade or downgrade a firmware version on an I/O module.

Managing Dell Force10 ToR Switch
Dell Force10 ToR switches along with their attributes are discovered and populated in the Active System Manager 
Operation Center view. This view enables methods to be executed on the Dell Force ToR switches for on-demand 
provisioning, as required.
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Dell Force10 ToR Switch Operations

Operation Description

Configure Switch This method is used to upgrade or downgrade a firmware version and upload the configuration file 
on a Dell Force10 ToR switch.

Managing Dell EqualLogic Storage
This section describes operations that can be performed from Operation Center view on the following EqualLogic 
Storage objects:

• Managing Storage Array Group

• Managing Storage Array Pool

• Managing Storage Array Pool Member

• Managing Storage Volume

Managing Storage Array Group

EqualLogic Arrays Group along with their attributes are discovered and populated in the Active System Manager 
Operation Center view. This view enables methods to be executed on EqualLogic Array Group for on-demand 
provisioning, as required.

Storage Array Group Operations

Operation Description

PoolCreate Creates new Storage Pool on an EqualLogic Storage 
Array.

Managing Storage Array Pool 

EqualLogic Storage Array Pool along with their attributes are discovered and populated in the Active System Manager 
Operation Center view. This view enables methods to be executed on EqualLogic Storage Array Pool for on-demand 
provisioning, as required.

Storage Array Pool Operations

Operation Description

PoolAddMember Adds a Storage Array to a given Storage Pool on an 
EqualLogic Storage Array.

PoolDelete Deletes a Storage Pool present on an EqualLogic Storage 
Array.

PoolRename Renames an existing Storage Pool present on an 
EqualLogic Storage Array.

Managing Storage Array Pool Member

EqualLogic Storage Array Pool Member along with their attributes are discovered and populated in the Active System 
Manager Operation Center view. This view enables methods to be executed on EqualLogic Storage Array Pool Member 
for on-demand provisioning, as required.

Storage Array Pool Member Operations
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Operation Description

Configure Raid Policy This method configures the required redundant array of independent disks (RAID) level on an 
EqualLogic Storage Array. Configure RAID type to one of the following RAID types: raid5, raid6, 
raid10, raid50, raid6-nospares, raid10-nospares, raid50-nospares, raid6-accelerated

Upgrade Firmware This method upgrades or installs another version of the firmware.

Managing Storage Volume

Volume on EqualLogic Storage along with their attributes are discovered and populated in the Active System Manager 
Operation Center view. This view enables methods to be executed on EqualLogic volume for on-demand provisioning, as 
required.

EqualLogic Group Members

Operation Description

VolumeOffline Sets a volume present on an EqualLogic Storage Array to offline.

VolumeOnline Sets a volume present on an EqualLogic Storage Array to online.

VolumeResize Resizes a volume present on an EqualLogic Storage Array

Managing VMware vCenter Objects
This section describes operations that can be performed from Operation Center view on following VMware vCenter 
managed objects:

• VMware Clusters

• VMware Hosts

• VMware Virtual Machines

• VMware Datastores

VMware Clusters 

VMware Clusters along with their attributes are discovered and populated in the Active System Manager Operation 
Center view. This view enables methods to be executed on clusters for on-demand provisioning, as required.

VMware Cluster Operations

Operation Description

Add DataStore To 
Cluster

This method adds the data store to an existing cluster.

List Cluster 
Datastore

This method lists the datastores on the cluster.

Move Host to Cluster This method moves the host that is present in data center level to the existing cluster.

VMware Hosts 

VMware hosts along with their attributes, are discovered and populated in the Active System Manager Operation Center 
view. This view enables methods to be executed on hosts for on demand provisioning, as required.

VMware Hosts Operations 
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Operation Description

Add DataStore to 
Host

This method is used to add an existing datastore to a cluster visible in Operations View.

Apply Host Profile This method is used for applying the specified profile to a specified Host. While applying the 
host profile please make sure both the Hosts physical configuration should be same. User can 
not apply the profile having more than one physical NIC to a host having single NIC.

Create Profile from 
Host

This method is used for creating Host Profile from a specified Host.

Enter Maintenance 
Mode

This method is used to put the ESX host into maintenance mode. VM running on the ESX hosts 
are suspended or migrated based on the ESX host configuration and passed parameters to this 
method.

Exit Maintenance 
Mode

This method is used to exit the ESX from maintenance mode and power on/restore the VMs 
which are suspended during the 'Enter Maintenance Mode' operation.

Display Resource 
Utilization

This method is used to view the resource utilization of the host.

List Host Datastore This method is used to view datastores on the host.

VMware Virtual Machines

VMware Virtual Machines, along with their attributes, are discovered and populated in the Active System Manager 
Operation Center view. This view enables methods to be executed on VMware Virtual Machines for on-demand 
provisioning, as required.

VMware Cluster Operations

Operation Description

Clone to Template This method is used to clone a Virtual Machine to a template.

Export OVF This method is used to convert a running Virtual Machine to an OVF.

Power Off VM This method is used to power off a VM.

Power On VM This method is used to power on a VM.

Resume VM This method is used to Resume a VM.

Suspend VM This method is used to suspend a running VM.

VMware Datastores

VMware Datastores, along with their attributes, are discovered and populated in the Active System Manager Operation 
Center view. This view enables methods to be executed on VMware Datastored for on demand provisioning, as required.

VMware Datastore operations

Operation Description

Remove Datastore This method is used to remove a data store from vCenter.
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7
Dashboard Reports

Resource Allocation by Sessions Report
This report provides resource allocation data for sessions that are in a Running state. This report displays CPU and 
memory allocations grouped by Active System Manager session, and can be used to view the CPU and memory 
allocation in a data center environment for particular time periods.

Resource Allocation by Sessions report

Resource Allocation by Hosts Report
This report provides resource allocation data for hosts on which some virtual resources are provisioned in running 
sessions. This report displays CPU and memory allocations grouped by hosts, and can be used to view a current usage 
of the CPU and memory allocation per host for a data center.

Resource Allocation by Hosts Report
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Resource Allocation by Groups Report
This report provides resource allocation data for virtual resources that are utilized in sessions owned by members of a 
group (grouped by group name). This report also captures the current allocation by groups and works for CPU and 
memory allocation.

Resource Allocation by Groups Report

Top Ten Resource Allocation Report
This report includes three sub-options for different groupings:

• By Host—Lists top ten hosts that are currently in use and have allocated maximum CPU and memory attributes.
• By User—Displays the list of top 10 users who are currently consuming the maximum number of CPUs and 

memory.
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• By Group—Similar to By User, but consolidated at the group level.

Top Ten Resource Allocation Report

Top Ten Resource Utilization Report
This report is similar to the Top Ten Resource Allocation report; however, this report provides utilization data as opposed 
to allocation. The required data is made available using a monitoring method that continuously keeps polling the device, 
VM, or cluster for current utilization data. The data is persisted in the database and the last polled data is provided to the 
user. This report can be grouped by the following:

• VMs
• Hosts
• Clusters
• Storage

Top Ten Resource Utilization Report by Cluster
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Top Ten Resource Utilization report by host

VM Utilization by Session Report
This report provides the most recent data for CPU and memory utilized on any VM, grouped by sessions. This data is 
available in terms of percentage with respect to the allocated limits.

VM Utilization by Session report

Host Utilization (Consolidated) Report
This report displays information about how much capacity is being utilized on a host by all running VMs, with respect to 
the allocated capacity. This report is available for CPU and memory attributes.

Host Utilization (Consolidated) Report

50



Cluster Utilization (Consolidated) Report
This report is similar to the Host Utilization (Consolidated) report. However, it uses clusters.

Cluster Utilization (Consolidated) Report

Storage Utilization (Consolidated) Report
This report provides storage utilization as a percentage of allocated storage for clusters.

Storage Utilization (Consolidated) Report
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CPU and Memory Utilization Over Time Graph for Hosts
This report provides CPU and memory utilization of hosts in percentage over a period of given time (for example, weekly, 
daily, and hourly).

CPU and Memory Utilization Showback Report

You can view the data for a specific time interval (with a minimum time interval limit of 10 minutes between two data 
points). To view the specific time interval data, select a point and drag the pointer to a desired data point. You can reset 
the time interval to default by clicking Reset Zoom.
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CPU and Memory Utilization Over Time Graph for Clusters
This report provides CPU and memory utilization of clusters in percentage over a period of given time (for example, 
weekly, daily, and hourly).

CPU Utilization Over Time Graph for Cluster 

Memory Utilization Over Time Graph for Cluster 

You can view the data for a specific time interval (with a minimum time interval limit of 10 minutes between two data 
points). You can also set the refresh interval based on which the report will be refreshed automatically. To view the 
specific time interval data, select a point and drag the pointer to a desired data point. You can reset the time interval to 
default by clicking Reset Zoom.
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8
Appendix A — Deployment Activities 

Verifying Active System Manager Services
To verify that all Active System Manager services are up and running, perform the following steps:

1. Log in as the user who installed the services.

2. Run the following script to display the current status of all services, including the Oracle database status:
cd $HOME/asm-galeforce/gf/sbin
./asmstatus.sh
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Sample output:
                          Active System Manager Services Status
Installation
----------------
Release Version: 7.1
Build Number: 21286
Database
----------------
Vendor: Oracle (Ver: 11.2.0.1.0)
Host: asm-galeforce Port: 1521
Service name: DB11G
Status: Running
Active System Manager Service
----------------------------------
Host: asm-galeforce Port: 40500 Secure Port: 50500
Enterprise: Dell
Lab: DEMO
Status: Running
Domain Services
----------------
1. Domain     : System (Id: 1)
   Description:
   ------------------------------------------------------
   Session server
      Host: asm-galeforce  Port: 40500  Secure Port: 50500
      Status: Running  
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9
Appendix B — Bill of Materials
The following table lists the bill of materials, grouped based on Resource Adapters.

Build of Material — Resource Adapters

Vendor Model Description

Dell Chassis Dell Chassis resource adapter using WSMAN and RACADM CLI 
used for discovery operations.

Dell Servers Dell Servers resource adapter using WSMAN and RACADM CLI 
used for provisioning the servers.

Dell IOA Management of IO Aggregator

Dell EqualLogicPS6110 Management of EqualLogic storage

Dell EqualLogicStoragePool Management of EqualLogic storage pool

Dell Force10-S4810 Management of ToR switches

Template VMwareLib VMware Host Provisioning on Blades

VMware Host VMware vCenter Management

VMware Virtual Machine VMware Virtual Machine Instance Management

The following table lists the bill of materials, grouped based on templates.

Bill of Material — Templates

ID Description Workflows

1 — Physical Cluster — VMware ESXi 5.1 Hypervisor 
deployment ISO boot

Configure ESXi Servers using ISO Boot, Cleanup-
Orchestration, and VMFS Datastore Provision.

2 — Physical Cluster — VMware ESXi 5.1 Hypervisor 
deployment PXE boot

Configure ESXi servers using PXE Boot, Cleanup-
Orchestration, and VMFS Datastore Provision.

3 — Physical Standalone — VMware ESXi 5.1 Hypervisor 
deployment PXE boot

Configure ESXi servers using PXE Boot, Cleanup-
Orchestration, and VMFS Datastore Provision.

4 — Physical Standalone — VMware ESXi 5.1 Hypervisor 
deployment ISO boot

Configure ESXi servers using ISO Boot, Cleanup-
Orchestration, and VMFS Datastore Provision.

5 — Logical Logical template with one VM connected to 
a VLAN

Built-in orchestration.

6 — Logical Logical template with two VMs connected 
to a VLAN

Built-in orchestration.
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Appendix C — Firmware and Software Base 
Lineup
The following tables list the minimum recommended firmware or software versions for Active System 800 components:

Active System 800 PowerEdge M620 Hypervisor Server

Device Revision

BIOS 1.7.6

CPLD 1.0.5

iDRAC7 Enterprise 1.40.40

LCC (Life Cycle Controller) 2 1.1.5.165

Network Controller Broadcom FW 7.6

EqualLogic MEM 1.1.2

VMware ESXi 5.1(1065491)A01

Active System 800 PowerEdge R620 Management Server

Device Revision

BIOS 1.6.0

iDRAC7 Enterprise 1.40.40

LCC (Life Cycle Controller) 2 1.1.5.165

Network Controller Broadcom FW 7.6

EqualLogic MEM 1.1.2

VMware ESXi 5.1(1065491)A01

Active System 800 Chassis, Storage, and Switches

Device Revision

CMC 4.4

PowerEdge M I/O Aggregator 8.3.17.4

Dell Networking MXL 10/40GbE Blade Switch 8.3.16.4

Dell Networking S4810 (LAN) 9.1(0.0)

Dell Networking S55 (OOB) 8.3.5.3

EqualLogic PS Array(s) 6.0.5

Active System 800 Management VMs and Software
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Device Revision

Windows Server 2008 R2 Standard 2008 R2 Standard

VMware vCenter Server 5.1 Update 1 5.1 Update 1

Dell EqualLogic Virtual Storage Manager (VSM) 3.5 EPA

Dell OpenManage Plug-in for vCenter 1.6.0.33

Dell Active System Manager 7.1

SAN HQ 2.5 EPA

VMware vCloud Connector 1.5

Dell OpenManage Essentials 1.2

Dell OpenManage Repository Manager 1.4.113
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Appendix D — Adding New ESXi PXE Images
This appendix describes the following topics related to adding new ESXi images:

• Preparing the VMware ESXi 5.x Installation Media

• Modifying the ESXi boot.cfg Configuration File

• Configuring the HTTP Server

• Creating a Kickstart Configuration File

Preparing the VMware ESXi 5.x Installation Media
To prepare the VMware ESXi 5.x installation media, perform the following steps:

1. Log in to www.dell.com.

2. Open the support and driver page: (http://www.dell.com/support/drivers/us/en/04/ProductSelector/Select?
rquery=fkey-e-Drivers_PS)

3. Select Server, Storage & Networking.

4. Select PowerEdge.

5. Select PowerEdge M620.

6. Select VMware ESXi 5.1.

7. On your Trivial File Transfer Protocol (TFTP) server, extract the contents of the installation ISO into a new directory 
using the following commands (login as the root user):
# mkdir /tmp/dellISO
# mkdir /tftpboot/esxi5.1_dell
# mount -o loop VMware-VMvisor-Installer-5.1.0-799733.x86_64-
Dell_Customized_RecoveryCD_A00.iso tmp/dellISO
# cp -fr /tmp/dellISO/* /var/lib/tftpboot/esxi5.1_dell/
# chmod +w /tftpboot/esxi5.1_dell/*

Modifying the ESXi boot.cfg Configuration File
To confirm if the installation source is not in the root of the TFTP server, perform the following steps:

1. Remove all slashes (/) from the boot.cfg file so that relative paths are used.
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2. Add a prefix directive to the boot.cfg file to specify the proper subdirectory, from the perspective of the TFTP root:

# cat boot.cfg
bootstate=0
title=Loading ESXi installer
kernel=tboot.b00
kernelopt=ks=http://xx.xx.xx.xx/esxi5.1_dell/ks.cfg
modules=b.b00 --- useropts.gz --- k.b00 --- chardevs.b00 --- a.b00 --- user.b00 
--- s.v00 --- misc_cni.v00 --- net_bnx2.v00 --- net_bnx2.v01 --- net_cnic.v00 
--- net_tg3.v00 --- scsi_bnx.v00 --- scsi_bnx.v01 --- net_bna.v00 --- 
scsi_bfa.v00 --- ima_be2i.v00 --- scsi_be2.v00 --- net_igb.v00 --- scsi_mpt.v00 
--- ima_qla4.v00 --- net_qlcn.v00 --- scsi_qla.v00 --- ata_pata.v00 --- 
ata_pata.v01 --- ata_pata.v02 --- ata_pata.v03 --- ata_pata.v04 --- 
ata_pata.v05 --- ata_pata.v06 --- ata_pata.v07 --- block_cc.v00 --- 
ehci_ehc.v00 --- weaselin.t00 --- esx_dvfi.v00 --- xlibs.v00 --- ipmi_ipm.v00 
--- ipmi_ipm.v01 --- ipmi_ipm.v02 --- misc_dri.v00 --- net_be2n.v00 --- 
net_e100.v00 --- net_e100.v01 --- net_enic.v00 --- net_forc.v00 --- 
net_ixgb.v00 --- net_nx_n.v00 --- net_qlge.v00 --- net_r816.v00 --- 
net_r816.v01 --- net_s2io.v00 --- net_sky2.v00 --- net_vmxn.v00 --- 
ohci_usb.v00 --- sata_ahc.v00 --- sata_ata.v00 --- sata_sat.v00 --- 
sata_sat.v01 --- sata_sat.v02 --- sata_sat.v03 --- sata_sat.v04 --- 
scsi_aac.v00 --- scsi_adp.v00 --- scsi_aic.v00 --- scsi_fni.v00 --- 
scsi_hps.v00 --- scsi_ips.v00 --- scsi_lpf.v00 --- scsi_meg.v00 --- 
scsi_meg.v01 --- scsi_meg.v02 --- scsi_mpt.v01 --- scsi_mpt.v02 --- 
scsi_rst.v00 --- uhci_usb.v00 --- tools.t00 --- scsi_qla.v01 --- dell_con.v00 
--- xorg.v00 --- imgdb.tgz --- imgpayld.tgz
build=
updated=0
# chmod +w /var/lib/tftpboot/esxi5.1_dell/*

Adding a PXE Menu Entry
Create a file named pxe.cfg containing the following code. Place this file inside the image directory on the TFTP server.
DEFAULT menu.c32
MENU TITLE ESXi-5.1 Boot Menu
NOHALT 1
PROMPT 0
TIMEOUT 80
LABEL install
  KERNEL esxi5.1_dell/mboot.c32
  APPEND -c /esxi5.1_dell/boot.cfg ks=http://KSFILEPATH +++
  MENU LABEL ESXi-5.1 ^Installer
LABEL hddboot
  LOCALBOOT 0x80
  MENU LABEL ^Boot from local disk
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The Resource Adapter dynamically replaces the KSFILEPATH value with the TFTP IP address value that is defined for 
the PXE Repo repository (assuming the TFTP server and the web server are running on the same machine). If dynamic 
replacement is not required, place the IP address (or host name) value of the web server where the ks.cfg file is located.

Configuring the HTTP Server
HTTP services are enabled, by default, on the appliance.

Creating a Kickstart Configuration File
To create a kickstart configuration file, perform the following steps:

1. Create the image directory on the HTTP server base location.
# cd /var/www/html
# mkdir esxi5.1_dell

The name of the directory needs to be same as the image directory created on the TFTP server.

2. Create a file named ks_template.cfg containing the following code. Place this file inside the image directory on the 
HTTP server.
# Sample scripted installation file
# Accept the VMware End User License Agreement
vmaccepteula
# Set the root password for the DCUI and ESXi Shell
rootpw <PASSWORD>
clearpart --firstdisk=<FIRSTDISK> --overwritevmfs
# Install on the first local disk available on machine
install --firstdisk=<FIRSTDISK> --overwritevmfs
# Set the network to DHCP on the first network adapter, use the specified 
hostname and do not create a portgroup for the VMs
<NETWORKCONTENT>
# reboots the host after the scripted installation is completed
reboot
%firstboot --interpreter=busybox
<FIRSTBOOTDATA>

• The value of <PASSWORD> will be replaced with the password string defined in the Resource Adapter 
configuration file. The default value is iforgot.

• The value of <FIRSTDISK> will be replaced by local/usb, depending on the boot sequence defined in the 
deployment template.

• The value of <NETWORKCONTENT> will be replaced for the DHCP or static IP address configuration. The default 
configuration is dhcp. If the value of the IP address, subnet mask, and name-server is provided in the inventory, 
then the static IP address configuration will be applied on the server.

• The value of <FIRSTBOOT> will be replaced by the network configuration template file, available inside the 
Resource Adapter package. The configuration is based on the specifications for the Active System 800 VMware 
Deployment document.

• The <FIRSTBOOT> configuration also includes:
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– iSCSI initiator configuration

– ESXi license Key. The value is added if the license key information is available in the resource adapter 
configuration file.

– Name of the Local datastore

Adding the New Image to the Software Repositories
If the new image is added by replacing the earlier image directory, then no change is required.

If the new image is added with a new name/directory, then the PXE Bootable Image repository must be updated, as 
described in the Updating Repository Elements for PXE Bootable Images section.
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Appendix E — Adding New ESXi ISO Images
This appendix describes the following topics related to adding new ESXi images:

• Preparing the VMware ESXi 5.x Installation Media

• Modifying the ESXi boot.cfg Configuration File

• Configuring the HTTP Server

• Creating a Kickstart Configuration File

Preparing the VMware ESXi 5.x Installation Media
To prepare the VMware ESXi 5.x installation media, perform the following steps:

1. Log in to www.dell.com.

2. Open the support and driver page: (http://www.dell.com/support/drivers/us/en/04/ProductSelector/Select?
rquery=fkey-e-Drivers_PS)

3. Select Servers, Storage & Networking.

4. Select PowerEdge.

5. Select PowerEdge M620.

6. Select VMware ESXi 5.1.
The image is listed in the Drivers for OS Deployment section.

7. On your Active System Manager appliance server, extract the contents of the installation ISO into a new directory 
using the following commands (log in as the root user):
# mkdir /tmp/dellISO
# mkdir /home/delladmin/ISOBootImages/esxi5.1_dell_ISOBoot_New
# mount -o loop VMware-VMvisor-Installer-5.1.0-799733.x86_64-
Dell_Customized_RecoveryCD_A00.iso /tmp/dellISO
# cp -fr /tmp/dellISO /home/delladmin/ISOBootImages/esxi5.1_dell_ISOBoot_New
# chmod +w /home/delladmin/ISOBootImages/esxi5.1_dell_ISOBoot_New/*

If the newly added image needs to replace the existing image, then execute following commands:
mv /home/delladmin/ISOBootImages/esxi5.1_dell_ISOBoot_New /home/delladmin/
ISOBootImages/esxi5.1_dell_ISOBoot

Modifying the ESXi boot.cfg Configuration File
To confirm that the installation source is not in the root of the TFTP server, perform the following steps:

1. Remove all slashes (/) from the boot.cfg file so that relative paths are used (vi :%s#/##g).
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2. Add a prefix directive to the boot.cfg file to specify the proper subdirectory, from the perspective of the TFTP root:
# cat boot.cfg
bootstate=0
title=Loading ESXi installer
kernel=/tboot.b00
kernelopt=ks=cdrom:/KS.CFG
modules=/b.b00 --- /useropts.gz --- /k.b00 --- /chardevs.b00 --- /a.b00 
--- /user.b00 --- /s.v00 --- /misc_cni.v00 --- /net_bnx2.v00 --- /
net_bnx2.v01 --- /net_cnic.v00 --- /net_tg3.v00 --- /scsi_bnx.v00 --- /
scsi_bnx.v01 --- /net_bna.v00 --- /scsi_bfa.v00 --- /ima_be2i.v00 --- /
scsi_be2.v00 --- /net_igb.v00 --- /scsi_mpt.v00 --- /ima_qla4.v00 --- /
net_qlcn.v00 --- /scsi_qla.v00 --- /ata_pata.v00 --- /ata_pata.v01 --- /
ata_pata.v02 --- /ata_pata.v03 --- /ata_pata.v04 --- /ata_pata.v05 --- /
ata_pata.v06 --- /ata_pata.v07 --- /block_cc.v00 --- /ehci_ehc.v00 --- /
weaselin.t00 --- /esx_dvfi.v00 --- /xlibs.v00 --- /ipmi_ipm.v00 --- /
ipmi_ipm.v01 --- /ipmi_ipm.v02 --- /misc_dri.v00 --- /net_be2n.v00 --- /
net_e100.v00 --- /net_e100.v01 --- /net_enic.v00 --- /net_forc.v00 --- /
net_ixgb.v00 --- /net_nx_n.v00 --- /net_qlge.v00 --- /net_r816.v00 --- /
net_r816.v01 --- /net_s2io.v00 --- /net_sky2.v00 --- /net_vmxn.v00 --- /
ohci_usb.v00 --- /sata_ahc.v00 --- /sata_ata.v00 --- /sata_sat.v00 --- /
sata_sat.v01 --- /sata_sat.v02 --- /sata_sat.v03 --- /sata_sat.v04 --- /
scsi_aac.v00 --- /scsi_adp.v00 --- /scsi_aic.v00 --- /scsi_fni.v00 --- /
scsi_hps.v00 --- /scsi_ips.v00 --- /scsi_lpf.v00 --- /scsi_meg.v00 --- /
scsi_meg.v01 --- /scsi_meg.v02 --- /scsi_mpt.v01 --- /scsi_mpt.v02 --- /
scsi_rst.v00 --- /uhci_usb.v00 --- /tools.t00 --- /scsi_qla.v01 --- /
dell_con.v00 --- /xorg.v00 --- /imgdb.tgz --- /imgpayld.tgz
build=
updated=0 
# chmod +w /home/delladmin/ISOBootImages/esxi5.1_dell_ISOBoot_New/*

Creating a Kickstart Configuration File
1. Create the image directory on the HTTP server base location:
# cd /home/delladmin/ISOBootImages/esxi5.1_dell_ISOBoot_New

The name of the directory needs to be same as the image directory created on the TFTP server.
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2. Create a file named ks.cfg containing the following code. Place the file in the image directory.
# Sample scripted installation file
# Accept the VMware End User License Agreement
vmaccepteula
# Set the root password for the DCUI and ESXi Shell
rootpw <PASSWORD>
clearpart --firstdisk=<FIRSTDISK> --overwritevmfs
# Install on the first local disk available on machine
install --firstdisk=<FIRSTDISK> --overwritevmfs
# Set the network to DHCP on the first network adapter, use the specified 
hostname and do not create a portgroup for the VMs
<NETWORKCONTENT>
# reboots the host after the scripted installation is completed
reboot
%firstboot --interpreter=busybox
<FIRSTBOOTDATA>

The value of <PASSWORD> will be replaced with the password string defined in the Resource Adapter 
configuration file. The default value is iforgot.

The value of <FIRSTDISK> will be replaced by local/usb, depending on the boot sequence defined in the 
deployment template.

The value of <NETWORKCONTENT> will be replaced for the DHCP or static IP address configuration. The default 
configuration is dhcp. If the value of the IP address, subnet mask, and name-server is provided in the inventory, 
then the static IP address configuration will be applied on the server.

The value of <FIRSTBOOT> will be replaced by the network configuration template file, available inside the 
Resource Adapter package. The configuration is based on the specifications for the Active System 800VMware 
Deployment document.

The <FIRSTBOOT> configuration also includes:

iSCSI initiator configuration

ESXi license Key. The value is added if the license key information is available in the resource adapter 
configuration file.

Name of the Local datastore

3. Copy the ks.cfg file to the HTTP Server base location.
mkdir –p /var/www/html/esxi5.1_dell_ISOBoot_New/
cp /home/delladmin/ISOBootImages/esxi5.1_dell_ISOBoot_New/ks.cfg /var/www/
html/esxi5.1_dell_ISOBoot_New/ks.cfg

If the existing image directory is being replaced, skip the above commands and execute the following:
mkdir –p /var/www/html/esxi5.1_dell_ISOBoot
cp /home/delladmin/ISOBootImages/esxi5.1_dell_ISOBoot/ks.cfg /var/www/html/
esxi5.1_dell_ISOBoot/ks.cfg
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4. Update the file permission on the newly added image:
chown –R delladmin:delladmin /home/delladmin/ISOBootImages
chmod –R +w  /home/delladmin/ISOBootImages/

Adding the New Image to the Software Repositories
If the new image is added by replacing the earlier image directory, then no change is required.

If the new image is added with a new name/directory, then the ISO Bootable Image repository must be updated, as 
described in the Updating Repository Elements for ISO Bootable Images section.
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Appendix F — Planning Worksheet 
Out of Band Management IP Address Configuration

Equipment IP Address Subnet Mask Gateway Username Password

Chassis 1 CMC

Chassis 2 CMC

iDRAC for all M620

Dell Force10 S4810 Switch1

Dell Force10 S4810 Switch2

EqualLogic Storage Array 
Management

Active System Manager 
Appliance

vCenter

ESXI Server IP Configuration
The following parameters for each server are required:

• ESXServerHostname— Hostname to be assigned to the ESXi server.

• ESXServerPassword — Server root password to be assigned during unattended installation.

• ESXiSCSIChapUsername— iSCSI CHAP username used to access volume of EqualLogic Storage Array

• ESXiSCSIChapSecret— iSCSI CHAP secret corresponding to iSCSI Chap username.

VLAN for IOA Configuration

Traffic Type VLAN

Management

vMotion

VM Workload(s)

iSCSI Management / Traffic

VMware Workloads:

• Administrator needs to create a volume on EqualLogic Storage Array manually

• This volume needs to contain the base line VMs that will be used for creating the VM workloads.

The base line VMs needs to have VMware Tools installed.
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Appendix G— PXE Setup Requirements
Consider the following before creating the DHCP Server:

• The PXE Network must be separate from the Management Network.

• Active System Manager must have a network interface with same subnet as the TFTP Server. Appliance uses 
ARP entries for identifying the IP Address assigned to the ESXi Servers by the DHCP Server.

• The Active System Manager VM appliance has predefined templates for installing ESXi 5.1 on the Dell blade 
servers using PXE boot. For enabling the Preboot Execution Environment (PXE) boot, the following additional 
services are configured on the appliance:

TFTP Server
TFTP services are enabled and deployed at /var/lib/tftpboot on the appliance. The ESXi Dell customized image is 
embedded within the appliance.

HTTP Server
HTTP services are enabled on the appliance.

DHCP Server
DHCP services are disabled on the appliance to avoid any issues with an existing DHCP server that may already be 
running on the same customer network. For the PXE setup requirement, the DHCP services should be running on the 
same network as the PXE. The DHCP server is configured to use Eth1 on the appliance.

The VM appliance is created with one vNIC. The vNIC needs to be in the Hypervisor Management Network.

Configuring PXE Setup with Embedded DHCP Server
The DHCP Services need to be enabled on separate network interface on the appliance. Before configuring the DHCP 
Services, add a new Virtual NIC on the appliance using the VMware vSphere client and restart the appliance.

Configuring the DHCP Server

1. Connect to the VM appliance console either through the VMware vSphere Client VM console or the Hyper-V VM 
console using the root user credentials.

2. Assign a static IP address on the eth0 interface. This IP Address must belong to the hypervisor Management 
subnet. If the DHCP server is running on a different subnet, add new interface and use it for DHCP.

3. Add the following content to the /etc/sysconfig/dhcpd file.
# Command line options here
DHCPDARGS=”eth1”

4. Edit the /etc/dhcp/dhcpd.conf file.

5. Update the values of the IP address ranges and subnets per the customer environment.
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6. Update the value of the next server with the VM appliance IP address on the same subnet as the DHCP server 
(eth0 IP address). The next-server represents the TFTP server where the image is hosted.

# DHCP Server for Hypervisor management network
# Uncomment following lines with appropriate IP Address range
subnet 192.168.122.0  netmask 255.255.255.0 {
    range 192.168.122.102 192.168.122.230;
    allow booting;
    allow bootp;
    filename “pxelinux.0”;
    next-server 192.168.122.101;
# --- default gateway
    option routers                  192.168.122.1;
    option subnet-mask              255.255.255.0;
    option domain-name-servers      192.168.122.1;
       option netbios-node-type 2;
    default-lease-time 28800;
    max-lease-time 28800;
}

Configuring the TFTP Server

The ESXi 5.1 customized image is embedded inside the appliance at /var/lib/tftpboot/esxi51._dell. The image is 
configured to create a kickstart file dynamically based on the IP address provided in the Active System Manager 
inventory.

If the ESXi host is configured to learn the IP address through DHCP (configured through orchestration), then there is no 
need to update the Server IP Address information in the Active System Manager inventory. The IP Address configured 
on the hosts by the DHCP server will be updated automatically during the server installation.

To start the DHCP services, execute the /etc/init.d/dhcpd restart command.

Configuring the PXE Setup with the Existing DHCP Server
If the DHCP server exists on the Hypervisor Management Network, perform the following steps:

1. Update the appliance’s DHCP settings to support the Bootstrap Protocol (BOOTP).

2. Edit the /etc/dhcpd/dhcpd.conf file. Update the next-server to point to the Active System Manager appliance IP 
address. The images are hosted on the appliance.
    allow booting;
    allow bootp;
    filename "pxelinux.0";
    next-server 192.168.122.101;
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Appendix H — FAQs

1. Volumes on EqualLogic Storage Array are not removed for canceled sessions. How to remove the unused volumes 
that wastes storage space and consumes iSCSI connections?
You should manually clean up the unused volumes on the EqualLogic Storage Array and iSCSI connections after 
session is canceled.

2. The orchestrations assume that Port Channel 2 is configured on the switches. If not, red links are displayed on the 
sessions to indicate failure.
The list of port-channels can be configured. Based on the environment, the port-channels list could be controlled 
by updating the portChannelList in the ssi.properties file under $HOME/asm-galeforce/gf/common/integrations/
Dell/Force10-S4810

3. Can I specify the datastore on which the VM should be created?
User can specify the datastore on which VM to be created. To specify the datastore, provide the value for 
TargetDatastore provisioning parameter of the VM in the template, as shown in the following figure. If the value is 
not provided for TargetDatastore parameter , the RA chooses the best available datastore for VM creation.

Provisioning Properties

4. Is there a way to revert a template or import the original template?
Yes. The original templates are available on the appliance, under the folder $HOME/DefaultTemplates

As a best practice:

– You should make a copy of the template and make the required modification in the cloned template.

– Keep the copy of the original templates by exporting them locally on a client machine and importing it back 
as needed.

5. What is the difference between synchronize and discovery?
During the discovery process, the following information is discovered and added to Active System Manager:
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– Inventory information

– Operation center view

– Link information

Synchronize process discovers only the Operation Center view hierarchy.

6. SSI properties are overwritten while upgrading the Resource Adapters (RA).
Yes, upgrading the RA will override the ssi.properties file. Before upgrading the RA, you should back up the RA 
directory.

To back up the RA directory:

– Log in the Active System Manager server as delladmin user

– cd $HOME/asm-galeforce/gf/common/integrations

– cp –r <manufacturer>/<model> <manufacturer>/<model>_<CurrentDate>

7. How Gold Volumes on EqualLogic Storage Array are secured?
Gold volume is secured by creating the access rights for the CHAP users.

To create a Gold Volume:

a. Create a volume of appropriate size on EqualLogic Storage Array.

b. Associate the CHAP account and associate it with the newly created volume.

c. Connect to the management host and configure the newly created datastore.

8. What about the images and firmware versions after the Active System Manager 7.1 release?
Images and firmware versions that are released after Active System Manager 7.1 release should work. However, 
these images and versions should be validated with the solution.

9. What is base level configuration and what is consists of for Dell Force10 switches?
Base level configuration is the minimal set of configuration running on the switches to bring them to an operational 
state. For more details on base level configuration, refer the embedded sample configuration file.

10. Is it required to create pools on EqualLogic Storage Array?
Creating pool is optional. If there are no user-defined pools on the EqualLogic Storage Array, then a newly created 
volume becomes part of the default storage pool. Pools can be created by executing the PoolCreate method on the 
EqualLogic group object in the Operation Center view. 

11. Is HTTPS supported for connecting to Active System Manager?
Yes. HTTPS is supported on Active System Manager.

12. Is terminal server connectivity required for Dell Force10 switches?
Terminal server connectivity to Dell Force10 switches is optional.

13. Does the default password of the Active System Manager appliance can be changed?
Yes. The appliance login password can be changed. If the password is changed, software repositories that are 
configured on Active System Manager Appliance should be modified with the new password.

14. How to identify the optional parameters in an orchestration step method?
Parameters with the * sign suffixed next to them are mandatory and the ones without * sign are optional. For 
example, see the following figure.
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15. When to add new images and firmware versions in the appliance?
Before they can be used for provisioning various resources in the environment, perform the following steps:

a. Discover the new versions using respective software repositories.

b. Associate the versions with the proper resource types and instances.

For details, refer to the Updating Repository Elements for ISO Bootable Images section.

16. If a customer is not going to use PXE deployments, are they still need to configure PXE?
PXE setup is optional. If a customer is not going to use PXE deployment. They can use the ISO boot solution of 
Active System Manager 7.1.

17. How to change the host name of the Active System Manager server?
To change the host name of the Active System Manager server:

a. Log in to the Active System Manager appliance as a root user.

b. Open the /etc/sysconfig/network file and specify the new host name in the HOSTNAME field.

c. Specify the host name in the /etc/hosts file.

d. Run the reboot command to restart the server.

e. Log in to the server as a delladmin user after restarting the server.

f. Run the hostname command to verify if the new host name is configured as host name.

g. Stop the Active System Manager services.

h. Change the directory using cd $HOME/asm-galeforce/gf/sbin

i. Run ./updateHostName.sh and follow the instructions to configure the host name in the Active System 
Manager installation.

j. Delete the following files from the directory:/home/delladmin/

* .ssh/id_rsa 

* .ssh/id_rsa.pub

k. Create a password less connection using the command ssh-keygen.

l. Start the Active System Manager Services. For details on starting and stopping the Active System Manager 
services, see the Configuring Active System Manager Services section.

18. Are VMware tools should be installed on Gold VMs images?
Yes. Gold VMs should have the current VMware tools installed.

19. Can the IOA/Chassis/Servers have different user name and password?
No. User name and password should be identical for IOA, Chassis and Servers.
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20. Can I add capacity to a cluster created using an ASM session?
You can add capacity to a cluster by running a new session (session_2) and running the same orchestration that 
you used for the currently running session (session_1) which created a cluster using ASM. The new session 
(session_2) will add the server/capacity to the same cluster that was created using session_1.

21. Can I add a new server in a session to add capacity to a cluster created using ASM session?
This is not supported. A cluster, once created, cannot be updated to add more capacity. You should cancel the 
reservation and recreate a session with increased capacity (increased server count) to create a cluster with more 
capacity. 

22. Can I remove a server from a session, to either free up the unused servers or to removing servers that have gone 
bad.
No. This is not a supported use case. 

23. Can I manage multiple Active System with same type (for example, 2X AS1000) or different type (for example, 
AS1000 and AS200), using a single ASM appliance?
Yes. A single ASM appliance can be used to manage multiple ASM appliance of the same type or different type.

24. ASM Template validation fails and the template cannot be scheduled if Active System elements are discovered 
separately.
This is as per the design, the DIS links are discovered only when the complete Active System discovery is 
performed. The DIS links are required for ASM template validation.

25. Interface mapping (DIS links) between the end devices is not correct as they do not represent the actual location 
of the end devices.
Links discovered during discovery do not represent the actual connection between the end devices, these links are 
dummy connections. The DIS links are discovered to represent the connections or links in the ASM template. This 
allows scheduling of the ASM templates with links in ASM template. 

26. What are the best practices for providing Asset Tag during discovery of an Active System?
User need to ensure that the Asset Tag provided in discovery setup does not match with the Manufacture or Model 
name pattern. For example, if Manufacture is EqualLogic and Model is StorageArray, the assetTag used during 
discovery should not have a pattern which matches either of “EqualLogic” or “StorageArray”. 

NOTE: In case user provides a name with pattern that matches Manufacture or Model than Virtual Object 
imported in ASM does not have the “Hypevisor” flag checked in inventory. User will have to manually enable 
the Hypervisor flag in this case. For enabling the Hypervisor flag on a resource instance in inventory, refer the 
ASM User Guide.

27. How the Workload VLAN’s which is defined in the VLAN component in ASM Template and Server Profile is 
configured by ASM?
ASM configures only Workload VLANs which are defined in ASM Template for Top of Rack switches configuration. 
However IOA is configured with VLAN’s which are defined in VLAN component as well as Workload VLAN’s 
defined in Server profile template. Thus for ensuring IOA and ToR switches are configured with same set of 
workload VLAN’s, make sure that workload VLAN’s defined in Server profile template should be a subset of VLANs 
defined on the VLAN component in ASM template. 

28. Do ASM configure NTP on the ESXi host?
NTP is not configured on the ESXi host; user needs to manually configure the NTP settings on the ESXi host. 

29. If vCenter and Active System nodes are not selected in the discovery configuration, the discovery initiated from the 
orchestration does not discover the vCenter or Active System elements
This is as per the design. To discover the vCenter or Active System elements, select the Active System elements 
and applicable vCenter entries in the discovery setup.

30. What is Gold/Base VM?
Virtual Machine with proper OS installed on it, exists on DataCenter and can be used to create one or more VM 
with same OS flavor.

76



31. How to use the Gold/Base VM ?
To use the Gold/Base VM, perform the following steps:

a. In the Templates view, double-click the ASM Logical Template.

b. In the Template editor, click the Virtual Machine resource type.

c. Click the Images File tab in the Properties section.

d. Click Add and select the discovered VM images to associate.

32. While creating /editing the server profile template or attaching server profile to a server, can I select firmware files 
from different repositories?
No. The selected firmware files must belong to a single repository. For example, if you choose iDRAC and BIOS 
firmware for update, both should be from the same repository.

33. Resource Adapter does not support VM cloning across datacenters.
Cloning of VMs across data centers is not supported in ASM 7.1 . The VM template or gold VMs should be in the 
inventory of the datacenter where you are deploying VMs to hosts.

34. Can I add new VLANs to a running physical session?

Yes, you can add new VLANs to a running session.

To add VLANs to a running session, perform the following steps:

a. From the Components view, drag the new VLAN component to a RUNNING session. To save the changes 
done to the RUNNING session, click Save on the toolbar.

This step will reserve a random VLAN ID from the range defined on the switch in the ASM Inventory. To 
specify a specific VLAN ID, perform the following steps:

1. Select the VLAN object in the Session editor.

2. In the Properties section, click VLANId in the Provisioning tab and specify the VLAN ID.

b. From the Link view in the RUNNING session, create the required links from the new VLAN component to the 
Dell Server instance and save the session.
This step will provision the new VLANs on the switch.

c. In the Networking Configuration editor, add the new VLAN ID that you added in the RUNNING session 
manually to the list of Networks. 

To open the Networking Configuration editor, use one of the following methods:

* On the menu bar, click Tools → Discovery → Networking 

* In the Setup perspective, click Networking on the toolbar.

d. Update the Server Profile Template to incorporate the new VLAN ID.
To update the Server Profile Template, perform the following steps:

1. In the Operation Center view, right-click a Server Profile Template in the Server Template And Profiles 
tab, and click Edit. 

2. In the Edit Server Profile Template dialog box, navigate to Network Settings page by clicking Next.

3. In the Network Setting window, select the Virtual NIC and click Edit.

4. In the Edit vNIC Configuration dialog box, update the new VLAN ID.

e. Run the custom operation AttachServerProfile using the following parameters:

* Parameter IOMsOnly should be set to “true”.

* Parameter ProfileIdList should have the list of profile IDs in a comma-separated format.

This step will provision the new VLANs on the IOA.
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f. Run the Dell Server custom operation “VMware - Update ESXi Server Port Group VLAN Info” to configure the 
required port-groups on the vSwitch corresponding to new VLAN component in session.
This step will add the new VLANs to the ESXi Host.

35. The step "Volume Create" of "AS800 - Cluster - VMware ESXi 5.1 Hypervisor deployment ISO boot" template fails.

This issue is observed because there is a connection limit of seven simulation connections to EqualLogic. The 
connections include SSH / Telnet /Web GUI connection. This limit is fixed and not adjustable.

Recommendation / Workaround :

– There should be only four sessions running in parallel using an EqualLogic Storage Group.

– If you want to provision a 32-blade cluster, then build the cluster using eight blades in each session. Do not 
initiate the session at the same time; schedule them sequentially and with the interval of 60 minutes.

36. The step "MEM Configuration" of template "AS800 - Cluster - VMware ESXi 5.1 Hypervisor deployment ISO boot" 
fails.

This issue is observed because there is a connection limit of seven simulation connections to EqualLogic. The 
connections include SSH / Telnet /Web GUI connection. This limit is fixed and not adjustable.

Recommendation / Workaround :

– There should be only four sessions running in parallel using an EqualLogic Storage Group.

– If you want to provision a 32-blade cluster, then build the cluster using eight blades in each session. Do not 
initiate the session at the same time; schedule them sequentially and with the interval of 60 minutes.

37. Why are orchestrations failing on servers with dual SD cards?
If a server has dual SD cards, the BIOS setting must be set to mirror mode to avoid orchestration failures.

38. How do I increase the number of logical deployments that can run concurrently on the system?

For better performance of the individual sessions, the appliance has a default limit of 10 parallel actions. Logical 
sessions are long-running so deploying more than 10 at a time will cause the system to queue up sessions greater 
than 10. This will also prevent other logical or virtual actions from being run until the logical jobs clear. If you need 
to run large batches of logical jobs the SSH session limit can be increased to allow other actions to be performed 
while those jobs are running.

The SSH session limit for parallel execution is set to 10 by default on the appliance. However, the session limit can 
be configured based on the requirement and if you face bottleneck because of it. ASM has been validated with 
parallel executions. Therefore, to reduce the waiting time, it is recommended to set the thread pool size and 
parallel execution count to less than or equal to 50.

To change the Parallel SSH execution limit on the appliance:

a. Log in as delladmin user.

b. Open the ./common/etc folder using the following command:

cd asm-galefore/gf/common/etc

c. Open the remoteExecServer.xml file and set the value for the following parameters to less than or equal to 50.

* Set poolsize — Attribute in the threadpool node.

* Set executioncount— Attribute in the maxparallel node.

d. Run the reboot command to restart the server.
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